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關於 i-Tree（About i-Tree） 

i-Tree是來自美國林務局最先進的同儕評閱（peer-reviewed）軟體套件，其提供

都市及社區林業分析與效益評估工具。i-Tree 工具藉由量化環境樹木提供的服

務及評估都市林結構，以幫助各種大小的地區加強他們的都市林管理與推廣

度。 

 

i-Tree已被社區、非營利組織、顧問、志工及學生用於記錄各種規模的都市

林，從單一樹木乃至社區、都市甚至整個國家。透過了解當地樹木實際提供的

生態系服務，i-Tree使用者可連結都市林管理活動、環境品質及社區的可居住

性。無論研究目標為單一樹木或整個森林，i-Tree的基礎資料供你證明價值及

確定優先度以做更有效的決策。 

 

由美國林務局與眾多合作夥伴共同開發，i-Tree設於公共網域上，可向 i-Tree網

站（www.itreetools.org）索取授權。林務局、Davey樹木專家公司（Davey Tree 

Expert Company）、植樹節基金會（Arbor Day Foundation）、市植樹師學會

（Society of Municipal Arborists）、樹木植栽國際協會（International Society of 

Arboriculture）以及 Casey Trees 皆已成為合作夥伴以利未來發展、傳播與為此

套件提供技術支持。 

 

i-Tree產品（i-Tree Products） 

i-Tree軟體套件 5.0版本包含以下各都市林分析工具及應用程式。 

 

i-Tree Eco 提供整個都市林的概況。其使用來自社區隨機分布樣區的現場資料

及當地每小時空氣汙染和氣象資料，以量化都市林結構、環境影響與對社區的

價值。 

 

i-Tree Streets側重於生態系服務及一個都市行道樹族群的結構。它使用一個樣

本或完整資料庫量化並將每棵樹的年度環境與美學效益以美元價格計算，包含

節約能源、改善空氣質量、減少二氧化碳、雨水控制及房地價增幅。 

 

i-Tree Hydro 是第一個針對植被的都市水文模型。其模擬都市林覆蓋變更的影

響，及流域層不透水表面的每小時河流流量和水質。 

 

i-Tree Vue讓你自由使用全國土地覆蓋資料庫（National Land Cover Database，

NLCD）的衛星圖像以評估社區的土地覆蓋，包含樹冠及當前都市林提供的一

些生態系服務。其也可模擬種植方案對未來效益的影響。 

 

i-Tree Species Selector 是一個獨立的工具，用於幫助都市林管理者根據環境功
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能和地理區域選擇最適合的樹種。 

 

i-Tree Storm幫助你在一場嚴重的颶風天災過後，立即以簡單、可靠又有效的

方式評估廣泛的社區損害。它適用於各種社區類型及大小，並提供關於時間與

減輕災害所需資金的資訊。 

 

i-Tree Design 是一個簡易的線上工具，提供一片樹林中單一樹木的評估平台。

此工具連接 Google地圖，使你了解樹木選擇、樹木大小及放置位置將如何影響

能源使用和其它效益。此工具仍在早期開發階段，更多精密的功能選項會在未

來版本釋出。 

 

i-Tree Canopy 提供一個快速簡便的方法，透過使用適合的 Google Maps 航空圖

像，產生土地覆蓋類型（如，樹木冠蓋）的有效統計性的估計。透過使用這些

資料，城市森林管理者可估計樹冠覆蓋、設立樹冠目標，及順利地進行追蹤，

且能為 i-Tree Hydro和其它需要土地覆蓋資料的專案估計所需數值。 

 

免責聲明（Disclaimer） 

本出版物中所使用之商品、商號或公司名稱僅為提供讀者資訊和便利，並非排

除其它可能適合之任何產品或服務的使用方式，所提及之商品、商號或公司名

稱也非受到美國農業部或林務局的官方認可或批准。標籤「i-Tree Software Suite 

v. 5.0」所發布之軟體，將不提供任何形式的擔保。它的使用受到最終用戶許可

協議（End User License Agreement，EULA）管轄，使用者在安裝前需先同意接

受該協議。 

 

回饋（Feedback） 

i-Tree開發團隊積極尋求關於此產品的任何回饋意見：軟體套件、使用手冊，

或是開發、推廣、支持和精細化的過程。請將評論根據 i-Tree支持頁面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介紹（Introduction） 

i-Tree Vue是一個獨立的應用程式，其允許你使用免費的國家土地覆蓋資料庫

（National Land Cover Database，NLCD）衛星圖像，評估你的社區樹冠及你都

市林提供的某些生態系統服務。此應用程式也可不同種植方案對未來生態系統

服務之影響。 

 

i-Tree Vue提供使用者許多更有效應用 NLCD 資料的方法。你可以使用 Google 

Maps 畫出基礎研究區域邊界的輪廓，根據美國林務局的研究調整樹冠及不透水

層估算，一點一點更新土地覆蓋以取得自 NLCD 發行日期起所發生的變化紀

錄，並使用 Google Maps 空拍圖與地圖資料改善 NLCD 圖像分析。 

 

了解你社區都市林及為良好的管理工作建立基礎的最佳方式是實地收集真實資

料，包括樹種、樹木大小及健康；i-Tree Eco 與 i-Tree Streets 兩個應用程式能幫

助你執行此任務。然而，有時候針對樹冠及與樹相關的效益之廣泛估計是有幫

助的，無論是作為更深入了解的第一步，或因為時間及財政資源有限。Vue專

為此情況設計。 

 

i-Tree Vue提供以下優點： 

 針對樹冠、空氣汙染相關之排除、碳儲存與美國鄰近地區年度碳封存，

它提供廣泛的估計。 

 它允許你輕鬆地探索 NLCD圖像與資訊。 

 它為研究區域提供針對土地覆蓋與不透水層的廣泛估計。 

 不需要任何實地資料。 

 不需任何軟體訓練或 GIS 技術以執行它。 

 不需大量都市林知識。 

 許多區域的結果報告可於一個小時內完成。 

 空間性地呈現樹冠與生態系統服務，讓你看見它們在你的社區範圍的差

異。 

 生態系統服務的數量與財政數值使用易於了解的摘要方式呈現。 

 可模擬樹冠變化的影響。 

 

Vue也有需注意的限制。這些與 NLCD 資料的性質（土地覆蓋資料是從 30 公尺

解析度的衛星圖像取得，且可能是幾年前的資料）、使用狀況、全國平均空氣污

染排除和全國平均碳儲存有關。這些限制將於〈附錄一〉詳細討論。 

 

關於本手冊（About This Manual） 

本手冊涵蓋所有使用 i-Tree Vue與更加認識你社區都市林所需的所有資訊。其

內容分為以下章節： 
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探索 Vue（Exploring Vue）：在幾分鐘內熟習華盛頓特區（Washington 

D.C）的 Vue及 NLCD 資料。 

 

第一節：開始進行（Section I: Getting Started）。在本節中，我們說明如何

收集免費的 NLCD 資料以執行 Vue。它可能比你所想的更容易！ 

 

第二節：使用 Vue（Section II: Working with Vue）。在本節中，你將體驗

簡單的控制與軟體執行的方式。 

 

第三節：生態系統服務（Section III: Ecosystem Services）。在本節中，我

們說明一項分析報告，其將估計你都市林的貢獻與未來潛力。 

 

第四節：更新土地覆蓋資料（Section IV: Updating Land Cover Data）。我

們將示範應如何更新你的 NLCD 資料，以更善用美國林務局的資訊，並反

映自圖像拍攝後，你研究區域的變化。 

 

附錄一（Appendix 1）：附錄一提供關於 i-Tree Vue限制的詳細說明、一些

技術性注意事項，以及基礎資料取得方式的相關資訊。 

 

附錄二（Appendix 2）：附錄二提供 NLCD 圖像與 ArcGIS v9.x 及 v10 進階

釘選的說明。 
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安裝（Installation） 

 

系統需求（System Requirements） 

最低硬體： 

 1 GHz 處理器與 1 GB 記憶體。 

 顯示器解析度 1024 x 768 或是更佳 

 

最低軟體： 

 Microsoft Windows 作業系統 XP SP3 或更高。 

 IE 7瀏覽器或更高。 

 Adobe Reader 9.0。 

 

安裝（Installation） 

欲安裝 Vue： 

1) 進入此網站（www.itreetools.org）下載軟體，或將 i-Tree軟體安裝光碟放

入 CD/DVD光碟機中。 

2) 按照螢幕的指示執行 i-Tree setup.exe檔案。根據所需的安裝檔案不同，

這將花幾分鐘的時間。 

3) 按照安裝小精靈的指示以完成安裝（建議安裝在預設路徑）。 

 

註：一定要進入此網站（www.itreetools.org）以取得更多資訊、電子報與使用

者論壇。並請記住，定期使用應用程式的定期檢查更新（Check for Updates）功

能，確保你擁有最新版本，因為我們將持續努力改善 i-Tree！ 

 

探索 Vue的範例專案（Exploring Vue with the Sample Project） 

欲開始背景設於華盛頓特區（Washington D.C）的 Vue功能，你可以跳到〈第

二節：使用 Vue〉，使用內建的範例專案。否則，從〈第一節〉開始，收集分析

你都市林所需之 NLCD 地圖。 

  

http://www.itreetools.org/
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第一節：開始進行（Section I: Getting Started） 

 

獲得 NLCD圖像（Obtain NLCD Imagery） 

你需要為你的研究區域從 NLCD下載三個圖像：土地覆蓋、森林樹冠百分比以

及不透水層百分比。Multi-Resolution Land Characteristics Consortium（MRLC）

是負責建立與維護 NLCD 的機構。他們的網路檢視窗是你獲得必需圖像的管

道。我們高度建議你複習他們的檢視窗指示。 

1) 進入此網站（www.mrlc.gov/finddata.php）並點擊 MRLC Consortium 

Viewer的頁面連結。 

2) 點擊 MRLC Consortium Viewer。允許你的瀏覽器開啟 MRLC 的彈跳性

視窗。 

3) 使用左側的縮放（Zoom）工具以準確地於視窗中聚焦在你的研究區域。 

4) 你可以使用 Display Tab 下的類別，例如地區、交通、邊界及水文，幫助

你劃清邊界。 

a) 點擊每個類別左側的三角形以展開選項，再勾選選框以於

地圖上顯示資訊。 

5) 聚焦於你研究區域後，請點擊右側的 Download Tab，再點擊土地覆蓋旁

的三角形，並為所需年份選取以下圖層： 

a) NLCD 20xx Land Cover 

b) NLCD 20xx Forest Canopy 

c) NLCD 20xx Impervious Surface 

 

選擇年份時請注意：森林樹冠資料不適用於 2006，但 2001的森林樹冠資料可

和 2006 的其他圖層資料混合。1992年的 NLCD 資料不相容於 Vue。 

 

6) 使用在左方工具列中的長方形 Download Tool在地圖上沿著你的研究區

域描繪一個框。讓框線範圍稍微超出你的研究區域。 

7) 在開啟的彈跳視窗中，確定三張圖像皆已列出，因為這三張圖像需同時

下載以確保它們有完全相同的範圍。 

a) 於每一圖層點擊 Download Button 時，Save File視窗將

開啟。根據伺服器需求，這兩個步驟間的等待時間可能會

很長。 

b) 點擊 Save後，瀏覽至欲儲存下載檔案的位置。將它們的

預設名稱變更為「Land_Cover」、「Tree_Canopy」以及

「Impervious」較為適當。 

在你偏好的位置將各壓縮檔解壓縮並記下這些位置，因為你在〈第二節〉中將

需要它們。各解壓縮資料夾包含一個元數據檔案（in .html 格式），其提供資料

的所有背景資訊。 
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釘選 NLCD圖像至專案區域（Clipping NLCD Imagery to a Project 

Area） 

由於 NLCD資料下載為長方形圖像，像數位相機照片，你可能需要裁切出你專

案區域的具體邊界。這將限制 Vue分析你確切研究區域中的樹冠。如果你熟悉

GIS 操作，你可以複習附錄二，該章節解釋如何使用 ArcGIS 精確裁切你的

NLCD資料。或者，前往〈第二節〉，應用 Vue的簡易釘選功能以使用 Google 

Maps 繪製你專案區域的邊界。此功能最適合小型、單一的區域。 
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第二節：使用 Vue（Section II: Working With Vue） 

欲開始使用 Vue工作： 

1) 點擊你電腦的開始選單 > 所有應用程式 > i-Tree > Vue。 

2) Browse for NLCD Imagery 視窗將開啟。 

 

請注意：如果你有意探索範本圖像，請點擊右下角的 Explore Sample 

Imagery。在開啟的彈跳式視窗內，你有兩個選項：使用未裁切的圖

像或使用裁切的圖像工作。 

1) 若選擇選項一，使用未裁切的圖像工作，你可以按照下方〈在

NLCD 圖像上定義 AOI區域〉的指示操作。 

2) 若選擇選項二，使用已裁切到專案區域的資料工作，你可以按

照下方〈了解 Vue環境〉的指示操作。 

 

3) 點擊土地覆蓋、樹冠及不透水覆蓋圖片的 Browse按鈕，瀏覽到解壓縮

每個檔案的資料夾位置。這些為原始的長方形 NLCD圖像（如果你按照

〈附錄二）的步驟操作，這些將是 GIS-裁切的圖像）。 

4) 三個圖像皆被載入後，請從下方的 Set Default Pollution Removal Values

下拉式選單中選擇正確的州別。這將載入與你的州別內，有關樹木的預

設汙染排除數值。 

 

請注意：如果你的社區已建立 i-Tree Eco 專案，你可以使用該專案的

結果而非預設資料。欲使用 Eco專案結果，請從下拉式選單中選擇 i-

Tree Eco專案。於開啟的視窗中瀏覽至儲存專案的位置，接著點擊

Open。 

 

5) 若欲在未裁切的 NLCD 圖像中定義 AOI區域，請勾選Manually Define 

an Area of Interest 旁的選框。請注意，此選項只適用於未裁切的圖像；

如果你已使用 GIS 裁切你的圖像，你不應使用此功能。 

6) 點擊 OK。 

7) 若選擇定義 AOI區域，一個新視窗將開啟供你編輯。若選擇不定義 AOI

區域，圖像將開始處理。處理圖像與計算統計數值可能會花一些時間。 

 

在 NLCD圖像上定義感興趣區域（AOI區域）──非必要

（Defining an Area of Interest on NLCD Imagery-optional） 

若你在以上步驟中選擇定義圖像的 AOI區域，Define AOI on NLCD Imagery

視窗將開啟。你下載的 NLCD圖像在右側，以紅線畫出你圖像範圍的 Google 

Maps 在左側。在這一步驟中，你將在 Google Maps 上繪製你的 AOI區域範

圍，細化邊緣，接著裁切並另存新檔為新的 NLCD 圖像。 



12 

 

1) 第一步是在 Google Maps 上繪製你 AOI區域的範圍。 

a) 平移（Pan）與縮放（Zoom）Google Maps 畫面是必要的。在

地圖與衛星視圖間切換，以協助你細化研究區域的邊線。 

b) 欲開始定義你的 AOI區域，請點擊 Draw AOI Footprint 按

鈕，之後在 Google Maps 上沿著你的研究區域點擊標記。適當

地在你的 AOI區域外繪製你的邊界線，此圖片由 30m 像素組

成。 

c) 你可以拖曳 Google Maps 的標記以調整邊界，你也可以點擊以

刪除各標記。如需重來，請點擊 Start Over按鈕。 

2) 完成邊界描繪後，請點擊 Draw AOI on NLCD 按鈕，將 Google Maps 邊

界傳送至 NLCD 圖像視窗。請注意，此視窗是由不同的地圖工具套組操

作的；將滑鼠游標停留在每一個工具上以閱讀工具描述。 

a) 使用 Toggle NLCD Images 按鈕於三個圖像上描繪，確保你已

取得你的 AOI區域。必要時，使用平移（Pan）與縮放

（Zoom）。 

b) 接著，請點擊 AutoClip 以清除邊界外大部分的 NLCD畫素。

這可能會花點時間。 

c) AutoClip 無法清除全部，因此你可以藉由點擊 TouchUp 

Eraser按鈕與各像素，移除你 AOI區域邊緣與內部的像素。

使用平移（Pan）與縮放（Zoom）提高操作精密度。 

d) 點擊 Save後，瀏覽至欲儲存已裁切圖像的資料夾。替各圖像

依需求命名，接著點擊 Save。 

3) 完成後，請點擊 OK，Vue將開始處理程序。處理圖像與計算統計數值

可能會花一些時間。 

 

了解 Vue設計（Getting to Know the Vue Layout） 

檢視窗（Viewports） 

NLCD圖像將出現在視窗的左上、右上及左下角。每一張圖像皆可藉由點擊在

右上角的Maximize按鈕最大化。右下角將用於分析結果。 

 

統計面板（Statistics panel） 

統計的標籤頁將於 Vue 視窗右側列出。General 標籤表示你研究區域的樹冠及

不透水層（以英畝與百分比）。五種土地覆蓋類別的細節會在之後的標籤呈現。

Pixel Info 標籤讓你更仔細地檢視各個 30 x 30 m 像素的組成。Classes標籤提供

NLCD土地覆蓋類別的描述。About標籤提供更多有關 Vue資訊的連結，Help

標籤則提供使用 Vue主視窗的指示。 

 

圖像工具（Image tools） 
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底部左側的工具提供透過一般 Zoom與 Pan 功能的圖像基本控制，包括 Full 

Extent縮放及 1:1 zoom工具。圖像的比例尺也可開啟或關閉。你可以直接

Measure（測量）圖像資料的解析度距離（~100 ft/30 m）。Print按鈕產生一個

簡單的圖像四塊編排。NLCD Statistics Report 顯示關於你研究區域的統計數

值，而旁邊的 NLCD Analysis Report顯示關於你研究區域的分析報告的統計數

值。將游標停留在工具上以檢視工具名稱。 

 

Google互動工具（Interactive Google tools） 

GoogleFind 及 GoogleVue 會幫助使用者解讀 NLCD 資料。GoogleFind 允許你

在四個圖像中點擊任一個點，以在彈跳視窗中的 Google Maps 上找到該位置。

點擊 Google Maps 產生的標記會顯示該位置的更多資訊。GoogleVue 允許你藉

由點擊四個圖像中的任一點，檢視 Google Maps 上疊層的清晰透明的 NLCD 圖

像。根據你點擊的 NLCD 圖片，一組 11 x 11 像素的土地、樹木、不透水層或

分析資料將在選擇的點產生。此功能允許你檢視與比較最近的 Google Maps 圖

像與 NLCD圖片。當 GoogleVue正在顯示 NLCD 土地覆蓋資料時，在像素上點

擊滑鼠右鍵將顯示 NLCD 類別。當 Vue的比例尺開啟時，它們也會出現在

GoogleVue地圖中。 

 

一旦點擊這兩個工具，它們將保持啟動狀態。在 NLCD圖片與 Google Maps 視

窗間有一些受限制的縮放和平移互動。Google Maps 視窗可以透過 UL、UR、

LL 和 LR按鈕（上下右左）被疊在四個檢視窗中的任一個。Undock 它以返回

為自由浮動視窗，而 X將關閉它。使用這兩個工具時需要高速網路連接。 

 

單位（Units） 

Units按鈕允許你在美國與公制單位間切換。 

 

分析選項（Analysis options） 

使用 Analysis Options按鈕以進入都市林業分析總機。這些分析皆為 i-Tree Vue

的核心要素。每一個分析在 Vue主視窗中針對一些生態系統服務提供報告與相

應的視覺化。此外，有些選項可供探索不同的樹冠覆蓋方案。各螢幕右側及以

下手冊內容皆會提供詳細的幫助。此分析可分為五種，並於下一節中深入描

述：碳移除 Carbon Removal、汙染移除 Pollution Removal、NLCD 覆蓋調整

NLCD Cover Adjustments、現有的都市林結構 Existing Urban Forest Structure

以及樹冠情境模型 Canopy Scenario Modeling。 

 

最後，分析選項包含在 NLCD Cover Adjustments 下的現狀微調 NLCD資料。 
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第三節：生態系統服務（Section III: Ecosystem 

Services） 

透過 Analysis Options按鈕取得的生態系統服務分析是 Vue的核心。針對你研

究區域的樹冠，年度碳移除（Carbon Removal）和汙染移除（Pollution 

Removal）皆會被分析，結果將以移除噸量與美元價值等方式呈現。現有都市

林結構（Existing Forest Structure）分析描述了可用種植空間量和現有樹冠覆

蓋。樹冠情境模型（Canopy Scenario Modeling）提供的方法可試驗樹冠增加

或損失對研究區域的影響，以及碳和污染清除的相關變化。 

 

大多數的結果描述你研究區域的整體情形，也可依土地覆蓋類型細分。碳或污

染的每畝移除量與相關的金錢價值之預設值，是基於國家和州的平均水平（或

你的 i-Tree Eco 專案）。例如，每畝的碳儲存量是使用全國平均水平的 9.1 kg 

C/m2或 81,188.3 lbs C/acre和貨幣價格的$20.68/ton 估計。請記住，各分析結果

皆代表來自樹木的效益。例如，農業土地覆蓋類型的碳儲存報告單指該土地覆

蓋類型中的樹木碳儲存，而非儲存於土壤、農作物等的總碳量。 

 

請注意：Vue可為你進行一些基本 NLCD 資料的更改，以產生更精確的結果。

這些程序將在〈第四節〉概述。 

 

碳和污染移除（Carbon and Pollution Removal） 

總碳儲存（Total Carbon Storage）分析估算儲存於你研究區域樹木的碳噸量

（也會顯示等量的 CO2噸量）。 

 

年度碳移除（Annual Carbon Sequestration）分析估算你研究區域樹木每年從

大氣移除的總碳噸量（也會顯示等量的 CO2噸量）。 

 

估算樹木汙染移除量的分析提供一氧化碳（Carbon Monoxide，CO）、二氧化

氮（Nitrogen Dioxide，NO2）、臭氧（Ozone，O3）、二氧化硫（Sulfur 

Dioxide，SO2）和 PM10（Particulate Matter, less than 10 microns）的估計量分

析。 

 

欲開始分析並檢視結果： 

1) 在 i-Tree Vue主視窗中，點擊 Analysis Options 按鈕。 

2) 在之後的分析操作界面中，選擇 Carbon Removal 或 Pollution Removal

分析之一，再點擊 OK。 

3) 開啟的輸入視窗將顯示你研究區域的預設國家（碳）或州（污染）平均

水平。如果你有更適合的當地資訊，可以在此輸入。 

4) 點擊 OK後，讓 Vue花點時間處理資訊。此處理程序以像素為單位進
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行，因此可能需要幾分鐘的時間。 

5) 結果將顯示在 Vue主視窗中的 Analysis Output 檢視窗。處理完成後，統

計報表也將出現。報告可從圖像工具欄取得，直到分析重新設置。 

 

現有的都市林結構（Existing Urban Forest Structure） 

Available Green Space 分析估算的可用種植空間，是總面積減去現有的樹冠覆

蓋，再減去不透水面。 

 

Canopy Green Space 呈現你研究區域的每畝總樹冠量和百分比。 

1) 從 i-Tree Vue主視窗點擊 Analysis Options 按鈕。 

2) 在之後的分析操作界面中，點擊 Available Green Space 或 Canopy 

Green Space，再點擊 OK。 

3) 在開啟的視窗中，勾選欲分析的土地覆蓋類型。 

4) 點擊 OK後，讓 Vue有時間來處理訊息。讓 Vue花點時間處理資訊。此

處理程序以像素為單位進行，因此可能需要幾分鐘的時間。 

5) 結果將顯示在 Vue主視窗中的 Analysis Output 檢視窗。處理完成後，統

計報表也將出現。報告可從圖像工具欄取得，直到分析重新設置。 

 

樹冠情境模型（Canopy Scenario Modeling） 

Vue具有一個非常有價值的功能，就是模擬樹冠覆蓋變化對環境效益的影響。

增加或減少樹冠覆蓋所造成的影響可透過四個選項探索： 

 

整個地區（Across the entire region）：此選項均勻調整整個研究區域的樹

冠覆蓋百分比。 

 

依五個一般 NLCD類別細分（Broken down by the five general NLCD 

classes）：此選項可獨立調整各開闊土地覆蓋類別的樹冠變化。 

 

所有已開發的 NLCD區域總和（Across the aggregate of all developed 

NLCD areas）：此選項可調整已開發區域的樹冠覆蓋百分比，並保留其他

土地覆蓋類型的狀況。 

 

依四個已開發 NLCD子類細分（Broken down by the four developed 

NLCD sub-classes）：此選項允許你在不同程度的已開發地區，獨立調整樹

冠覆蓋程度。例如，非常密集的城市中心可能有比郊區更低的樹冠覆蓋目

標。在此選項中，所有未開發地區皆保持不變。 

 

欲調整樹冠程度： 

1) 在 i-Tree Vue主視窗中，點擊 Analysis Options 按鈕。 
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2) 在之後的分析操作界面中，選擇其中一個模擬情境方案，再點擊 OK。 

3) 所開啟的視窗將顯示你現有的樹冠覆蓋程度以及最大可用種植空間（定

義為沒有現存的樹木和沒有不透水層的地區）。 

a) 針對每種土地覆蓋，輸入欲模擬的樹冠覆蓋程度。其不可超越

最大可能樹冠（Maximum Possible Tree Canopy），若數值低

於現有樹冠（Existing Tree Canopy），樹冠的損失將被模擬。 

b) 若你希望為任何生態系統服務編輯每英畝或每貨幣金額的預設

值，勾選每個服務旁的選框。相應的欄位將出現以供編輯。 

4) 點擊 OK後，讓 Vue有時間來處理訊息。讓 Vue花點時間處理資訊。此

處理程序以像素為單位進行，因此可能需要幾分鐘的時間。 

5) 結果將顯示在 Vue主視窗中的 Analysis Output 檢視窗。處理完成後，統

計報表也將出現。報告可從圖像工具欄取得，直到分析重新設置。 

 

報告選項（Reporting Options） 

所有 Analysis Options輸出處理的時間取決於系統資源和 NLCD圖像尺寸。在

較慢的機器上，處理可能需要幾分鐘。視窗底下的進度條顯示處理作業進度。

偶爾，進度會因你電腦上運作的其他系統活動而遲滯。這時，你不應該退出程

序。相反地，你應等待幾分鐘，讓處理完成。 

 

檢視（Viewing） 

處理完畢後，Analysis Output 圖像將出現在 Vue主視窗右下角的檢視窗，而

NLCD Analysis Report 將出現在一個彈跳視窗。分析結果的 Executive 

Summary 表格和 Full Report 皆會提供。點擊加號開啟新層級，或點擊 Expand 

All 以同時檢視全部報告。輸出圖像被用於將整個研究區域的現象可視化，並可

於 Statistics Panel 上的 Pixel Info 標籤仔細檢視。 

 

列印（Printing） 

該四個圖像可依它們顯示於當前檢視窗的方式與各自的比例尺一起列印。點擊

圖像工具欄中的 Print 按鈕以列印。接著點擊開啟的 Print Preview 視窗中的

Print按鈕。 

 

報告的 Print按鈕位於該報告底部。報告將以它們出現在螢幕上的狀態被列印

出來──包含各層級的展開或折疊。 

 

保存（Saving） 

欲保存分析輸出的圖像檔案和相應的 NLCD 圖像，請點擊主視窗右下角的 Save 

Output按鈕。瀏覽至欲儲存的位置後，替檔案命名，再點擊 Save。圖像的.tif

檔案及 GIS 程式的.tfw 檔案皆會被儲存。 
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使用報告底部的 Save按鈕，可將該報告保存為逗號分隔（comma-delimited）的

文本文件（.csv）。Microsoft Excel 可開啟 Executive Summary的逗號分隔文件，

以進一步編輯和格式化。 
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第四節：更新土地覆蓋資料（Section IV: Updating 

Land Cover Data） 

在 NLCD資料有侷限性。首先，可以確定 NLCD 資料將低估樹冠覆蓋和不透水

層（參考〈附錄一〉了解更多）。其次，因為開發 NLCD圖像產物需要很長的

時間，你的研究區域可能會在此期間經歷顯著的變化。最後，由於 30 x 30 m 像

素的粗糙性，樹冠或不透水層的量可能不正確。在某個像素內，小樹木或小區

域路面可能會被周遭的土地覆蓋「排除（washed out）」。這種圖像擁有這些限制

──我們應記住，這種圖像是免費的，且能被統計管理。 

 

欲解決以上提到的第一個限制，美國林務局（U.S. Forest Service，USFS）承辦

了一個取樣活動，透過航空攝影解讀技術辨識樹冠與不透水層的區域性低估。

這些修訂的區域性數值可輸入至 Vue以改善結果。另外，你也可以考慮使用 i-

Tree Canopy程式替你的當前樹冠百分比進行統計估計。i-Tree Canopy百分比和

i-Tree Vue呈現的 NLCD 數值之間的差異是你的校正因子，且能輸入至 Vue。 

 

為了解決第二和第三個限制，Vue的新功能讓你於個別像素中，使用 Google 

Maps 針對小區域更新土地覆蓋、樹冠和不透水層資訊。 

 

均勻調整分佈在整個研究區域的樹冠水平和不透水層（Adjusting 

Canopy Levels and Impervious Cover Evenly Across your Study 

Area） 

欲更改均勻分佈在整個研究區域的樹冠和不透水層之預設 NLCD資訊： 

1) 在 i-Tree Vue主視窗中，點擊 Analysis Options 按鈕。 

2) 在之後的分析操作界面中，點擊 Tree Canopy 或 Impervious Cover，再

點擊 OK。 

3) 該二分析表單呈現 USFS 針對鄰近美國地區的研究區域地圖和其調整值

列表。 

a) 使用 Zoom和 Pan 操作地圖，找到包含大量研究區域的區

塊。 

b) 確認你的區塊後，針對該區域，點擊地圖下方列表中的

adjustment factor。上面標記為「差異（Difference）」。相應數

值將出現在上方的框框內。 

另一方面，欲使用根據 i-Tree Canopy調查的校正因子，針對整個研究區域，在

上方的框框內輸入 i-Tree Canopy樹冠百分比與 i-Tree Vue樹冠百分比的差異。 

點擊 OK。這些更動將於依像素為單位進行，可能需要幾分鐘的處理時間。 

 

以像素為單位調整土地覆蓋類別（Adjusting Land Cover 
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Classification Pixel by Pixel） 

下方說明將描述如何更改各像素資料的三個部分：（1）土地覆蓋分類（例如，

高度開發、混合林、水等），（2）該像素之樹冠平均百分比，以及（3）該像素

之不透水層平均百分比。 

 

試想，舉例而言，某地區的 NLCD圖像產生時，該地區仍是高密度森林區，之

後被開發為一個郊區住宅區。根據 NLCD 資料，這個區域的像素可能會顯示為

「森林，落葉（Forest, deciduous）」，並有 100％樹冠覆蓋和 0％不透水層。然

而，就目前的情況而言，更準確的描述為「已開發，低度（developed, low 

intensity）」，並有 30％樹冠覆蓋和 20％不透水層。 

 

下方說明將描述如何更改資料的這三個部分。高速網路連線是必要的。 

1) 在 i-Tree Vue主視窗中，使用 zoom和 pan 瀏覽至 NLCD圖像中欲更動

的位置。 

2) 點擊 Analysis Options按鈕。 

3) 在之後的分析操作界面中，選擇 Land Cover 並點擊 OK。Google Maps 

Pixel Navigator視窗將開啟。 

4) 在瀏覽視窗中，進一步使用 zoom和 pan 至欲更新的區域。 

5) 點擊 Fetch Land Cover Pixel Subset 按鈕。NLCD 土地覆蓋類別像素將

出現在瀏覽地圖上。你可以在像素上滾動，在地圖區域的右下角，土地

覆蓋分類、樹冠（TC）和不透水層（IC）將顯示。 

6) 欲針對個別像素更新土地覆蓋、樹冠和/或不透水層： 

a) 若欲改變土地覆蓋類別，選擇地圖下方的新土地覆蓋類型。 

b) 若欲改變樹冠水平，勾選樹冠（Tree Canopy）旁的 edit 框，

並移動滑動條至正確的水平。 

c) 若欲改變不透水層水平，勾選不透水層（Impervious Cover）

旁的 edit框，並移動滑動條至正確的水平。 

d) 接著，在地圖上右鍵點擊相應像素，以同時更改資料的這三個

部分。 

e) 因此方法主要依賴 Vue 和 Google Maps 的協調，請別過快點

擊。 

f) 滑鼠游標停在某像素上方時，新數值將出現於右下角的當前數

值（Current values）下。 

g) 欲更仔細檢視下方的 Google Maps 細節，你可以點擊 Hide 

Land Cover Pixels。點擊 Show Land Cover Pixels 以繼續使用

它作業。 

7) 點擊幫助（Help）面板下的 Advanced 按鈕，查看更改後的 NLCD 圖像

為何。你可能需要 Zoom及 Pan 這些圖像以找到所編輯的區域。 
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8) 編輯各像素後，定期點擊 Commit Changes 按鈕保存更新後的圖像。 

9) 全部的步驟──步驟四至八──根據需要，可重複數次。 

10) 完全完成編輯後，點擊 OK。你的已編輯圖像將被加載到 Vue中。 

 

若你對預設資料的調整感到滿意，你即可返回〈第三節〉，繼續分析和檢視你已

改善的 NLCD資料的結果。 
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附錄一：限制和資料注意事項（Appendix 1: 

Limitation and Data Notes） 

 

限制（Limitations） 

i-Tree Vue提供樹冠覆蓋和部份都市林生態系統服務的粗略估計，且不要求用戶

收集實地資料。如果沒有實地資料收集，估計只能算是非常粗糙的近似值，在

資料和估計上也將有些顯著的侷限性。 

 

儘管有這些限制，i-Tree Vue專為城市地區提供生態系統服務的簡單初階的估計

值。這些資料可以於查看現有覆蓋與服務的差異、樹木覆蓋改變的潛在效益變

化，並作為跳板，使 i-Tree Eco 或 i-Tree Streets 的服務估計更精確。這些資料不

應被視為最後或準確的都市林覆蓋或環境服務估計。 

 

廣義估計（Generalized estimates） 

i-Tree Vue的基本方法是使用國家土地覆蓋資料庫（National Land Cover 

Database，NLCD，http://www.mrlc.gov）所開發的空間森林覆蓋地圖，以及應

用樹冠覆蓋每單位的平均生態系統服務值，估計當地區域的服務。這個廣義作

法使用國家和州平均值，在地方性規模有明顯的侷限性。 

 

NLCD樹木覆蓋估計（NLCD tree cover estimates） 

NLCD提供為美國地區提供具 30米像素解析度的樹木覆蓋估計。這個國家資料

庫提供了我們國家樹木資源的重要訊息，但也有其侷限性，特別是針對地方性

規模。自 NLCD覆蓋地圖的樹木覆蓋估計已被證明全國樹木覆蓋率平均將被低

估 10％（Nowak and Greenfield 2010）至 28％。同樣地，不透水層估計平均被

低估 1.4％到 6％。基於 Nowak和 Greenfield 的成果（2010），Vue 的功能允許

你對區域內的樹冠和不透水層粗略調整。 

 

空氣污染清除估算（Air pollution removal estimates） 

為更精確地估計城市中的污染清除情形，需要當地的污染和氣象資料，以及葉

面積指數（樹冠深度）和樹冠覆蓋的估計。由於地方性資料在 i-Tree Vue中是

未知的（除了樹木覆蓋估計），i-Tree Vue使用每平方米樹冠覆蓋的每年污染清

除估計（g/m2/yr）的國家平均值，計算地方性的污染清除，並假設葉面積指數

為 6﹝即是，每平方米樹冠覆蓋的 6平方米葉面（單面）﹞。隨著污染濃度、

天氣和都市林葉面積指數可於地方有明顯差異，因此，i-Tree Vue估計越粗略越

好。你的區域條件與國家平均值和葉面積指數 6 越接近，i-Tree Vue的估計與你

的區域便越接近。更精確的估算可透過收集當地的實地資料，以及使用 i-Tree 

Eco或 i-Tree Streets。更多有關如何計算污染移除的資訊將於下方說明。 
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碳儲存與封存估計（Carbon storage and sequestration estimates） 

為更精確地估計城市的碳儲存（目前在樹木中的碳量）和每年碳封存（一年中

所清除的碳量），當地的環境條件（例如，樹木競爭、生長季長度）與樹木密

度、物種和直徑分佈等資訊皆是必要的。由於在 i-Tree Vue中，地方性資料是

未知的（除了樹木覆蓋估計），i-Tree Vue採用全國平均估計以求近似當地的碳

影響。碳封存和儲存數值是樹木覆蓋（平方米）乘以平均碳儲存（9.1kg 

C/m2），封存密度值（0.3kg C/m2）則從美國許多城市（例如， Nowak 和 

Crane 2002, Nowak 和 Greenfield 2008）所計算而來。由於樹木母群體和環境變

量可在地方有顯著差異，i-Tree Vue的粗略估計是最好的。你的區域條件越接近

群體平均，因此，i-Tree Vue估計越粗略越好。你的區域條件與群體平均越接

近，i-Tree Vue的估計與你的區域便越接近。更精確的估算可透過收集當地的實

地資料，以及使用 i-Tree Eco 或 i-Tree Streets。 

 

美元價值估計（Dollar value estimates） 

生態系統服務的貨幣估算是基於每噸污染物或碳量數值的文獻估計。有關城市

樹木碳儲存和碳封存的貨幣價值，是根據 2001-2010年預計的邊際社會二氧化

碳排放成本，為$22.8/t C（Fankhauser 1994）。污染清除的美元數值估算，是使

用從 1994 年在能源決策中制定的國家客觀性中間值進行估計（Murray et al. 

1994, Ottinger et al. 1990）。基於生產者價格指數，將 1994年的數值調整至 2007

美元（U.S. Dept. of Labor 2008）。這些數值，以美元/噸（t）為單位，分別如

下： 二氧化氮（NO2）= $9,906/t，PM10 = $6,614/t，二氧化硫（SO2）= 

$2,425/t，一氧化碳（CO）= $1,407/t。對於臭氧（O3）的客觀值設定為等於二

氧化氮（NO2）的數值。客觀值可被認為是產生該汙染之產品或服務的市場價

格針對社會的污染估計成本。 

 

估算空氣污染移除的方法（Methods for Estimating Air Pollution 

Removal） 

空氣污染清除的估計來自於 Urban Forest Effects（UFORE）模型（Nowak 和

Crane 2000）以及 2000 年氣象和污染資料（National Climatic Data Center 2000, 

U.S. EPA 2008）。UFORE 模型被用於整合城市或社區的樹木覆蓋資料中，每小

時污染和氣象資料，以估算各州的每年污染清除（Nowak and Crane 2000, 

Nowak et al. 2006）。 

 

欲計算各州的城市森林污染，州污染通量率（每年每樹冠平方米的污染清除公

克數）是來自 1994年都市林移除國家污染的研究（Nowak et al. 2006）。隨著污

染物濃度因時間而變化，根據 1994年與 2000年間的平均區域汙染濃度改變，

1994年汙染通量率被調整為 2000年（U.S. EPA 2003）。通量率＝沈積速度*污

染濃度，每年間的污染濃度比率被用於更新通量率。 
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算術平均值被用於二氧化氮、PM10和二氧化硫濃度值；2nd max 8小時二氧化

碳平均值；和 4th max 8小時臭氧平均值，以確定 1994年和 2000年間的變化率

（U.S. EPA 2003）。新的 2000年通量率乘以城市或社區樹木覆蓋值，可估計樹

木的總污染清除數值。 

 

NLCD圖像技術說明（NLCD Imagery Technical Notes） 

多元學習（Learn more） 

參考Multi-Resolution Land Characteristics Consortium（MRLC）網頁

（www.mrlc.gov），以學習關於他們的目標以及 NCLD資料在 i-Tree Vue的應

用。特別檢閱他們 FAQ部份的 NCLD資料簡報。 

 

四捨五入（Rounding） 

NLCD圖像資料的每一個圖像像素，皆以數值 0 到 100儲存。因此，新的樹冠

估計結果必然四捨五入。四捨五入在輸出的樹冠資料組中，可能會扭曲用戶定

義的樹木覆蓋估計高達百分之一。當你在處理涵蓋非常小的 AOI區域的區塊或

土地覆蓋時，扭曲將更加明顯。此外，碳和污染數值並不實際儲存於圖像像素

中，因四捨五入它們將降低有效性。相反地，樹冠—現存或新估計—皆被儲存

於圖像像素中。在 i-Tree Vue中，碳和污染數值皆即時計算，以顯示於像素訊

息窗中。碳和污染圖像輸出後，你可以使用你 GIS 程式中所選擇的碳和污染數

值乘以儲存後的樹冠數值。 

 

投影系統（Projection system） 

請參照 www.mrlc.gov 或圖像附加的元資料檔案以獲取更多訊息： 

Projection ALBERS 

Datum NAD83  

Spheroid GRS80  

Units METERS  

Zunits NO  

Xshift 0.0  

Yshift 0.0 

Parameters  

29 30 0.0 /* 1st standard parallel  

45 30 0.0 /* 2nd standard parallel  

-96 0 0.0 /* central meridian  

23 0 0.0 /* latitude of projection’s origin  

0.0 /* false easting（meters）  

0.0 /* false northing（meters） 
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附錄二：使用 ArcGIS釘選 NLCD 圖像（Appendix 

2: Clipping NLCD Imagery with ArcGIS） 

Vue提供了一個簡單的功能，能將 NLCD 的圖像範圍釘選到你的研究區域，但

如果你能使用 GIS，透過 GIS 的強大功能，你將發現能更容易地裁切並釘選。 

 

ArcGIS v. 9.3 & v. 10 

ArcGIS v. 9.3 或 v. 10 可於來裁切釘選圖像，並不需要任何擴充套件。 

1) 加載三個 NLCD 圖像到新的 ArcMap專案「FIRST」。這將投影系統設置

以符合圖像，是 Vue正常運作的關鍵。不要重新投影 NLCD圖像，這將

扭曲 NLCD圖像的像素，並捨棄 Vue的所有運算。 

2) 欲提取來自各 NLCD圖像的投影區域，請瀏覽 ArcToolBox > Data 

Management Tools > Raster > Raster Processing > Clip。 

3) 如下填寫裁切表格： 

a) Input Raster應為從MRLC 網站下載的不透水層、樹冠或土地

覆蓋圖像。 

b) Output Extent 是欲釘選的多邊形邊界 shapefile。 

c) 勾選 Use Input Features for Clipping Geometry (optional)旁的

選框。 

d) 對於 Output Raster Dataset，在你的硬碟上，瀏覽至一個合適

的位置，以.TIF檔名命名該輸出資料集（Output Dataset）：

「your_layer_name.tif」。請注意：TIF 和 TFW 檔案將於選定

的輸出位置被創建。 

e) NoData Value (optional)應留空。 

4) 完成後，關閉 ArcGIS 以開啟用於 Vue的釘選圖像檔案。 

 

ArcGIS v. 9.2 

使用 ArcGIS v. 9.2 的用戶需取得 Spatial Analyst 擴充程式進行裁剪。 

1) 為使用 Spatial Analyst，在 ArcMap的主選單中，選擇 Tools > Extensions 

> Spatial Analyst。 

2) 加載三個 NLCD 圖像到新的 ArcMap專案「FIRST」。這將投影系統設置

以符合圖像，是 Vue正常運作的關鍵。不要重新投影 NLCD圖像，這將

扭曲 NLCD圖像的像素，並捨棄 Vue的所有運算。 

3) 欲提取來自各 NLCD圖像的投影區域： 

a) 請瀏覽 ArcToolBox > Spatial Analysis Tools > Extraction > 

Extract by mask。 

b) 將你專案的 AOI多邊形圖層地圖設置為面板。 

4) 欲輸出三個提取的資料集： 
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a) 右鍵點擊 layer name > Data > Export Data。 

b) 更改輸出資料的位置（記住，只要在輸出文件夾位置上點擊一

次即可）。 

c) 更改格式為 TIFF。 

d) 根據需求調整名稱。 

e) 保留其他選項的預設值。 

5) 按照以下步驟，創建三個輸出圖像的World File（*.TFW）：ArcToolBox 

> Data Management Tools > Raster > Raster Properties > Export Raster 

World File。 

6) 完成後，關閉 ArcGIS 以開啟用於 Vue的釘選圖像檔案。請注意，Vue原

先可能以灰階模式呈現這些圖像，但仍會嘗試替每個圖像應用適當的顏

色。 

 

 


